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Frontispiece (continued). (Figure shown on previous page.) The University of Hawaii operates a broadband three-
component seafloor seismometer at the Hawaii-2 Observatory (Duennebier et al., 2000, 2002). While drilling at the site,
data from the observatory showed environmental noise as well as drilling-related noise from the JOIDES Resolution. A. These
time series of vertical motion of the seafloor show four wave packets of fin-back whale songs. For each wave packet the
whale emits a wavelet ~1 s long. The four wavelets in each wave packet correspond to various sound propagation paths in
the ocean. Although we did not visually observe whales while we were at Site 1224, whale calls were frequently observed
in the seismic data. B. Root-mean-square (RMS) levels are a convenient way to summarize the seismic data. This figure
shows RMS levels of horizontal motion in an octave band centered at 8 Hz for 7 January 2002. The T-phases from three
earthquakes as well as drawworks noise from the JOIDES Resolution can be identified.
References
Duennebier, F.K., Butler, R., Chave, A., Harris, D., Jolly, J., and Babinec, J., 2000. Broadband seismograms from the Hawaii-2 Observatory [paper presented

at Am. Geophys. Union Mtg., San Francisco, Fall 2000].
Duennebier, F.K., Harris, D.W., Jolly, J., Babinec, J., Copson, D., and Stiffel, K., 2002. The Hawaii-2 Observatory seismic system. IEEE J. Oceanic Eng.,

27:212–217.
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Reference to the whole or to part of this volume should be made as follows: 
Print citation for Chapter 1:
Shipboard Scientific Party, 2003. Leg 200 summary. In Stephen, R.A., Kasahara, J., Acton, G.D., et al., 
Proc. ODP, Init. Repts., 200: College Station TX (Ocean Drilling Program), 1–72.

CD-ROM volume citation:
Stephen, R.A., Kasahara, J., Acton, G.D., et al., 2003. Proc. ODP, Init. Repts., 200 [CD-ROM]. Available 
from: Ocean Drilling Program, Texas A&M University, College Station TX 77845-9547, USA.

CD-ROM chapter citation:
Shipboard Scientific Party, 2003. Site 1223. In Stephen, R.A., Kasahara, J., Acton, G.D., et al., Proc. 
ODP, Init. Repts., 200, 1–159 [CD-ROM]. Available from: Ocean Drilling Program, Texas A&M 
University, College Station TX 77845-9547, USA.

This volume also appears on the World Wide Web. See www-odp.tamu.edu/publications for Web 
citation formats.

http://www-odp.tamu.edu/publications
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Effective publication dates of ODP Proceedings

According to the International Code of Zoological Nomenclature, the date of publication of a work 
and of a contained name or statement affecting nomenclature is the date on which the publication 
was mailed to subscribers, placed on sale, or when the whole edition is distributed free of charge, 
mailed to institutions and individuals to whom free copies are distributed. The mailing date, not the 
printing date, is the correct one.

The printing date of this volume: January 2003

The mailing dates of recent Proceedings of the Ocean Drilling Program:

Volume 197 (Initial Reports): August 2002
Volume 198 (Initial Reports): October 2002
Volume 199 (Initial Reports): November 2002
Volume 176 (Scientific Results): December 2002
Volume 178 (Scientific Results): December 2002
Volume 180 (Scientific Results): September 2002

Copies of this publication may be obtained from Publications Distribution Center, Ocean Drilling 
Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-9547, USA. See the 
ODP publication list at www-odp.tamu.edu/publications or contact ODP for prices and ordering 
information. Orders for copies require advance payment.

ISSN
Book: 0884-5883; CD-ROM: 1096-2522; World Wide Web: 1096-2158
Library of Congress 87-642-462

http://www-odp.tamu.edu/publications
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PUBLISHER’S NOTES
This volume also appears on the World Wide Web. Any scientific corrections, revisions, or additions will 
be noted in the chapter (see “Chapter Notes”) at www-odp.tamu.edu/publications.

This publication was prepared by the Ocean Drilling Program, Texas A&M University, as an account of 
work performed under the international Ocean Drilling Program, which is managed by Joint 
Oceanographic Institutions, Inc., under contract with the National Science Foundation. Funding for 
the program was provided by the following agencies at the time of this cruise:
Australia/Canada/Chinese Taipei/Korea Consortium for Ocean Drilling: Department of Primary Industries and 
Energy (Australia), Natural Resources Canada, National Taiwan University in Taipei, and Korean Institute for 
Geology, Mining and Minerals

Deutsche Forschungsgemeinschaft (Federal Republic of Germany)

European Science Foundation Consortium for Ocean Drilling (Belgium, Denmark, Finland, Iceland, Ireland, Italy, 
The Netherlands, Norway, Portugal, Spain, Sweden, and Switzerland)

Institut National des Sciences de l’Univers–Centre National de la Recherche Scientifique (INSU-CNRS) (France)

Marine High-Technology Bureau of the State Science and Technology Commission of the People’s Republic of 
China

National Science Foundation (United States)

Natural Environment Research Council (United Kingdom)

University of Tokyo, Ocean Research Institute (Japan)

http://www-odp.tamu.edu/publications
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Any opinions, findings, and conclusions or recommendations expressed in this publication are those of 
the author(s) and do not necessarily reflect the views of the National Science Foundation, the 
participating agencies, Joint Oceanographic Institutions, Inc., Texas A&M University, or Texas A&M 
Research Foundation.

Abbreviations for names of organizations and publications in ODP reference lists follow the style given 
in Chemical Abstracts Service Source Index (published by American Chemical Society).

The bulk of the shipboard-collected data from this leg is available on the World Wide Web and is 

accessible at www-odp.tamu.edu/database. If you cannot access this site or need additional data, 
please contact the ODP Data Librarian, Ocean Drilling Program, Texas A&M University, College Station 
TX 77845-9547, USA. E-mail: database@odpemail.tamu.edu.

Supplemental data were provided by the authors and may not conform to ODP publication formats.

Some close-up photographs of very dark cores have been tonally enhanced to better illustrate 
particular features of interest.

A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available on the 
volume CD-ROM in PDF format. These maps were produced using Generic Mapping Tools (GMT) of 
Paul Wessel and Walter H.F. Smith (gmt.soest.hawaii.edu).

Cover photograph is fungal hyphae within a carbonate-filled cavity in a massive tholeiitic lava flow 
unit. The photograph was taken by microbiologist Gabriela Schumann-Kindel.

http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
http://gmt.soest.hawaii.edu
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FOREWORD

BY JOINT OCEANOGRAPHIC INSTITUTIONS, INC.

This volume presents scientific and engineering results from the Ocean Drilling Program (ODP). These results 
address the scientific and technical goals of the program, which are focused on the study of the dynamics of 
Earth’s interior and environment, the evolution of oceanic crust, and the fluctuations of climate. In addition, 
study of the Earth’s deep biosphere is an emergent research objective.

ODP, an international partnership of scientists and research institutions from 22 countries, operates the drillship 
JOIDES Resolution. This state-of-the-art research vessel contains eight levels of laboratories and other scientific 
facilities required for carrying out the program’s objectives.

The management of ODP involves a partnership of scientists and governments. International oversight and 

coordination are provided by the ODP Council, which is made up of representatives from the member 
countries. Overall scientific and management guidance is provided by representatives from the Joint 
Oceanographic Institutions for Deep Earth Sampling (JOIDES).

Joint Oceanographic Institutions, Inc. (JOI), a nonprofit consortium of 18 U.S. oceanographic institutions, serves 
as the National Science Foundation’s prime contractor for ODP. JOI implements scientific objectives, plans, and 
recommendations of the JOIDES committees through major subcontracts to Texas A&M University (TAMU) for 
science operations and to Lamont-Doherty Earth Observatory (LDEO) of Columbia University for geochemical 
and geophysical well-logging services.

JOI, TAMU, and LDEO have worked together successfully for many years to manage the Ocean Drilling 
Program. We look forward to many exciting discoveries and continued international collaboration as we further 
our scientific mission, especially the planning for the future of ocean drilling beyond 2003.

Steven R. Bohlen
President of the Joint Oceanographic Institutions and Executive Director of the Ocean Drilling Programs
Washington, D.C.
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1. Leg 200 Summary
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CD-ROM CONTENTS: CORE DESCRIPTIONS
Visual core descriptions (VCDs) and smear slide and thin section data tables are included in this 
section. ASCII versions of the smear slide data tables are also available (see “ASCII Tables”).

Site 1223

Visual Core Descriptions · Smear Slides · Thin Sections

Site 1224

Visual Core Descriptions · Smear Slides · Thin Sections
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CD-ROM CONTENTS: ASCII TABLES
This CD-ROM contains ASCII versions of selected expanded coring summary, paleomagnetic, thermal 
conductivity, lithologic age, moisture and density, anhysteretic and isothermal remanent 
magnetization, and P-wave velocity data tables from the text and all of the smear slide data tables 
presented under “Core Descriptions.” A complete listing of the ASCII tables can be found listed below. 

You can access these data directly from the PDF files. Depending on your computer platform, the 
following information applies.

PC COMPUTERS
By default, double-clicking on a filename with a .TXT extension will launch the Notepad application. 
You can configure your computer’s operating system so that files on this CD with .TXT extensions 
automatically open in other software, such as Microsoft Excel. Follow these steps from the pull-down 

menu: Windows 95 and NT operating systems: View > Options > File Types; and Windows 98, 2000, 
ME, and XP systems: View > Folder Options > File Types.

MACINTOSH COMPUTERS
All table files with .TXT extensions will automatically open into Excel. If you do not have Excel installed 
on your computer, you may view these files through other spreadsheet or text-editor programs. Open 
the application of your choice, select File > Open, and open the ASCII file.

UNIX COMPUTERS
You can open files with .TXT extensions in any text editor or spreadsheet program, but not directly 
from PDF files.

Chapter 3 Chapter 4 Smear slide data tables  
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Chapter 3, Site 1223
Table T2. Expanded coring summary, Site 1223.
Table T8. Drilling-disturbed intervals and gaps that affect paleomagnetic results, Hole 1223A.
Table T9. Paleomagnetic data from archive-half sections, Hole 1223A.
Table T10. Principal component analysis results from paleomagnetic data from archive-half sections, 
Hole 1223A.

Table T11. Paleomagnetic data from discrete samples, Hole 1223A.
Table T12. Anhysteretic remanent magnetization (ARM) data from discrete samples, Hole 1223A.
Table T13. Isothermal remanent magnetization (IRM) data from discrete samples, Hole 1223A.
Table T14. Principal component analysis results from paleomagnetic data from discrete samples, 

Hole 1223A.

Table T16. Ages of lithologic units, Hole 1223A.
Table T17. Thermal conductivity measurements, Hole 1223A.
Table T18. Moisture and density, Hole 1223A.
Table T19. P-wave velocity sensor (PWS) measurements, Hole 1223A.

Chapter 4, Site 1224
Table T3. Expanded coring summary.
Table T7. Moisture and density, Site 1224.
Table T8. Thermal conductivity measurements, Site 1224.
Table T9. P-wave sensor (PWS) measurements, Site 1224.

Smear Slide Data Tables
Site 1223 smear slide table.
Site 1224 smear slide table.
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CD-ROM CONTENTS: SUPPLEMENTARY MATERIAL
The Initial Reports CD-ROM contains supplementary data files presented in Microsoft PowerPoint and 
ASCII. The PowerPoint files present all the petrographic features of volcanic basement at Site 1224. 

The first four files deal mainly with petrographic definitions and the classification of the massive lava 
flows (phenocrysts and groundmass); the next two files deal with pillow-related features; and the last 
two files deal mainly with alteration. The photomicrograph log is presented in ASCII. Supplementary 
material files are located in the SUPP_MAT directory.

PETROL
PET_IA.PPT
PET_IB.PPT
PET_IC.PPT
PET_ID.PPT
PET_IIA.PPT
PET_IIB.PPT
PET_IIIA.PPT
PET_IIIB.PPT

PHOTOMIC
PHOTOMIC.TXT
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CD-ROM CONTENTS: DRILLING LOCATION MAPS
A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available in PDF.

ODP Leg 200 Site Map 

ODP Map (Legs 100–200)

DSDP Map (Legs 1–96)
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RELATED LEG DATA

DOWNHOLE LOGGING AND CORE DATA 

A CD-ROM that contains Leg 200 depth-shifted and processed logging data and ODP core data was 
produced in conjunction with this leg and is included with the printed version of this volume. The 
“Log and Core Data” CD contains logging data provided by the Borehole Research Group at the 

Lamont-Doherty Earth Observatory, Logging Services Operator for ODP, and ODP core data (gamma 
ray attenuation bulk density, moisture and density, magnetic susceptibility, natural gamma radiation, 
P-wave velocity, and color reflectance).

Most of the logging and core data included on this CD are available on the World Wide Web at 
www.ldeo.columbia.edu/BRG/ODP. If you cannot access this site or want to order the CD, please 
contact the ODP Logging Services Operator at the Lamont-Doherty Earth Observatory of Columbia 
University, PO Box 1000, 61 Route 9W, Palisades NY 10964, USA; Tel: (845) 365-8341; Fax: (845) 365-
3182; E-mail: borehole@ldeo.columbia.edu.

The majority of the core data on the CD are available on the Web at www-odp.tamu.edu/database. 
If you cannot access the ODP database or need additional data, please contact: ODP Data Librarian, 
Ocean Drilling Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-
9547, USA; Tel: (979) 845-8495; Fax: (979) 458-1617; E-mail: database@odpemail.tamu.edu.

http://www.ldeo.columbia.edu/BRG/ODP
mailto:borehole@ldeo.columbia.edu
http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
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COMPILED ELECTRONIC INDEX
The Compiled Electronic Index of the Proceedings of the Ocean Drilling Program included on the volume 
CD-ROM contains individual indexes of Volumes 101–173, 174B–176, 178, and 180. The indexes are 
contained in the directory titled ODPINDEX and are named ###NDX.PDF (### = the leg number). 
These indexes can be searched individually or collectively.
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CD-ROM DIRECTORY STRUCTURE 

SUPP_MAT
(Supplementary Material)

PETROL
(PowerPoint presentations of 
petrographic features of volcanic
basement at Site 1224)

PET_IA.PPT (Phenocrysts and groundmass,
Part 1)

PET_IIA.PPT (Pillow-related features, Part 1)

PET_IIB.PPT (Pillow-related features, Part 2)

PET_IIIA.PPT (Alteration, Part 1)

PET_IIIB.PPT (Alteration, Part 2)

ACROREAD
(Acrobat Reader installation 
software and instructions for 
different platforms)

200IR.PDF
(Preliminary pages and table of contents)

README.TXT

IR200_01.PDF (Leg 200 Summary)VOLUME
(Leg 200 Initial Reports volume)

README.PDF
(Information about the volume CD-ROM)

README.TXT
(ASCII version of information about the volume CD-ROM)

MAPS
(Drilling location maps)

ODPMAP.PDF
(ODP map, Legs 100 through 200)

CHAPTERS
(Volume chapters)

200_MAP.PDF
(Leg 200 site map)

IR200_02.PDF (Explanatory Notes)

IR200_03.PDF (Site 1223)

IR200_04.PDF (Site 1224)

DSDPMAP.PDF
(DSDP map, Legs 1 through 96)

TABLES
(ASCII versions of expanded coring
summary, paleomagnetic, thermal
conductivity, lithologic age, moisture
and density, anhysteretic and
isothermal remanent magnetization,
P-wave velocity, and smear slide
data tables)

IR200_03 (Site 1223)

IR200_04 (Site 1224)

S_SLIDES (Sites 1223 and 1224)

README.TXT

COR_1223.PDF (Site 1223)CORES
(Visual core descriptions, smear slide
and thin section data tables,
and digital core images)

COR_1224.PDF (Site 1224)

IMAGES (PDF files of core images)

MAC

UNIX

WINDOWS

INDEX.PDX
(Acrobat file used to enable Acrobat Search of the
200 Initial Reports)

PET_IB.PPT (Phenocrysts and groundmass,
Part 2)

PET_IC.PPT (Phenocrysts and groundmass,
Part 3)

PET_ID.PPT (Phenocrysts and groundmass,
Part 4)

(Continued on next page)
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CD-ROM DIRECTORY STRUCTURE (CONTINUED)

ODPINDEX
(Compiled Electronic Index of the
Proceedings of the Ocean Drilling
Program)

101NDX.PDF through 173NDX.PDF, 174BNDX.PDF 
through 176NDX.PDF,178NDX.PDF, and
180NDX.PDF
(Index files)

NDX.PDX
(Acrobat file used to enable Acrobat Search of the
Compiled Electronic Index)

PHOTOMIC
(ASCII photomicrograph log)

PHOTOMIC.TXT (Photomicrograph log)SUPP_MAT
(Supplementary Material)
(continued) README.TXT
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